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This User's Guide describes the basic operations of AT-View Plus VLAN Manager.  

 

1 Overview 
 

VLAN Manager is a tool that enables you to configure VLANs on a device using a graphical user 
interface (GUI) or by importing VLAN definitions from a file. 

Topics 

• Starting VLAN Manager  
• Main Window  
• Basic Operations  
• Menus  
• Device Support  

 
1 Overview 
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2 Starting VLAN Manager 
 

VLAN Manager can be started from AT-View Plus Device Manager or from the command line. 
In a Windows environment, VLAN Manager can be started from the AT-View Plus program 
folder or from the Run command of the Start menu. 

You can start VLAN Manager from AT-View Plus Device Manager by clicking on Tool > 
VLAN Manager on the main menu or by clicking on the VLAN Manager icon on the toolbar. 
If AT-View Plus Device Manager is connected to a device, target host information is 
automatically passed on to VLAN Manager so that the VLAN configuration of the device can be 
retrieved and displayed in VLAN Manager's main window. 

 
2 Starting VLAN Manager 
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3 Main Window 
 

When started, VLAN Manager displays one of the following windows, depending on how it is 
started. 

Topics: 

• Initial Window 
• VLAN Information Window 

 
3 Main Window 
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3.1 Initial Window 
 

If the target host is not specified, or if one or more connection parameters do not match what is 
configured on the host, the following window appears. 

 
Initial Window 

To specify a target host from this window, select File > Open. If the target host is a device model 
that is supported by VLAN Manager, the VLAN Information Window displaying the target host's 
VLAN configuration will appear. 

 
3 Main Window 
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3.2 VLAN Information Window 
 

When a target host is specified and VLAN Manager recognizes it as a device model that it 
supports, the following window appears. 

 
VLAN Information Window 

The menu bar provides access to VLAN Manager's operations. 

The VLAN Information Window displays the VLAN configuration of the device being managed. 
Information is organized in a table format with each row representing one VLAN definition and 
each column representing one attribute of the VLAN. VLAN attributes displayed differ from one 
device family to another. Refer to Section 6 - Device Support for the specific attributes displayed 
for each device family. 

 
3 Main Window 
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4 Basic Operations 
 

This chapter discusses the basic operations within VLAN Manager windows. 

Topics 

• Selecting VLAN Definitions 
• Device Panel 
• VLAN Configuration Files 

 
4 Basic Operations 
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4.1 Selecting VLAN Definitions 
 

To select a VLAN definition in the VLAN Information Window or the Import VLAN dialog box, 
click on a row. To select multiple contiguous VLAN definitions, hold down the Shift key while 
clicking on the desired VLAN definitions. To select multiple non-contiguous VLAN definitions, 
hold down the Ctrl key while clicking on the desired VLAN definitions. 

 
4 Basic Operations 
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4.2 Device Panel 
 

A device panel that reflects the actual ports available on the target host is used to create or 
modify a VLAN definition. 

Note - The AT-A48/SC, AT-A48/MT and AT-A49 Expansion Modules for the AT-8350GB are 
not supported and will not show up on the device panel.  

 
Device Panel 

A port can be in any of the following states: 

Port Image State Description 

 Not Selected This port does not belong to the VLAN. 

 Selected 

This port is an untagged member of the VLAN. 

Note - For the AT-8200XL Series, this port is considered a member 
of the VLAN. 

Note - For the AT-8600, AT-8700XL, AT-8800, Rapier, AT-8900 
and AT-9900 series, this port is a private untagged member of the 
Private VLAN. 

Note - For the AT-8900 and AT-9900 series, this port is a customer 
port of the Nested VLAN. 

 Flagged 

This port is a tagged member of the VLAN. 

Note - For the AT-8200XL Series, this port is considered an 
untagged (port-based) member of the VLAN. 

Note - For the AT-8600, AT-8700XL, AT-8800, AT-9900, Rapier 
and AT-8900 series, this port is a private tagged member of the 
Private VLAN. 

Note - For the AT-8900 and AT-9900 series, this port is a core 
member of the Nested VLAN. 
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Port Image State Description 

 Selected 

Note - For the AT-8600, AT-8700XL,AT-8800, Rapier, AT-8900 
and AT-9900 series, this port is an uplink untagged member of the 
Private VLAN. 

Note - For the AT-9700, this port is a forbidden member of the 
VLAN. 

 Flagged 
Note - For the AT-8600, AT-8700XL, AT-8800, Rapier, AT-8900 
and AT-9900 series, this port is an uplink tagged member of the 
Private VLAN. 

Clicking on a port will change its state as follows: 

Current State New State 

  

  

  

  

  

  

 
4 Basic Operations 
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4.3 VLAN Configuration Files 
 

VLAN Configuration Files are Comma Separated Value (CSV) files containing VLAN 
definitions and are used by the Import VLAN and Export VLAN functions. 

The format of the VLAN Configuration File is as follows: 

VLAN_Entry1_Name, VLAN_Entry1_Identifier, attribute1, 
attribute2, etc. 

VLAN_Entry2_Name, VLAN_Entry2_Identifier, attribute1, 
attribute2, etc. 

and so on... 

The number and order of VLAN attributes, and their corresponding values, differ from one 
device family to another. Refer to Section 6 - Device Support for details on the specific attributes 
for each device family. 

The following is an example of a VLAN Configuration File for the Rapier 24i device that 
contains two (2) VLAN definitions: 

prod,2,Private,"","10,12,14","12","10,14" 

test,3,Normal,"20-21","19,22","","" 
 

4 Basic Operations 
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5 Menus 
 

This chapter describes the items on VLAN Manager's main menu. 

Topics: 

• File  
• Edit  
• View  
• Tools  
• Help  

 
5 Menus 
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5.1 File 
 

The File menu lets you connect to and disconnect from a target host, check the properties of the 
target host, or exit VLAN Manager. 

Topics: 

• Open  
• Close  
• Properties  
• Exit  

5.1.1 Open 

This option allows you to specify a target host to connect to. When you select File > Open, the 
following dialog box appears. To connect to the device, fill in parameters in the dialog box, and 
click OK. 

Note - This option is not available if VLAN Manager is already connected to a target host. 

 
Open dialog box 

IP Address  
This is the Host Name or IP Address of the target host.  
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SNMP Version  

This drop down list allows you to select the SNMP version to use in managing the target 
device.  
   
Note - Before choosing "v2c" or "v3", make sure that the target device you are connecting 
to supports SNMP v2c and/or SNMP v3 respectively.  
   

Settings  
If the Version is set to "v1" or "v2c", this button opens the SNMP v1/v2c Settings 
window. Otherwise, if the Version is set to "v3", this button opens the SNMP v3 Settings 
window.  
   

 
SNMP v1/v2c Settings dialog box  
   
Community Name  
The community strings to use in performing SNMP operations on the target host. There 
are two types of community strings for SNMP. Be sure to specify strings which match the 
ones configured on the target host.  
By default, the following strings are used:  
   
for the 'Get' operation  
public  
   
for the 'Set' operation  
private  
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SNMP v3 Settings dialog box  
   
User Account Name  
This is the SNMPv3 User Account to be used for accessing the MIB of the target device. 
Make sure to specify a User Account that has already been configured on the target 
device.  
   
Security Level  
This is the Security Level for the User Account Name that you have specified. Make sure 
to set the Security Level that is configured for the User Account Name on the target 
device.  
These are the available Security Levels:  
   
No Auth / No Priv  
This Security Level uses no authentication and no privacy.  
   
Auth / No Priv  
This Security Level uses authentication without privacy.  
   
Auth / Priv  
This Security Level uses authentication and privacy.  
   

Note - Do not use a user account with a security level of AUTHPRIV to connect to an 
AT-9700 device. Doing so will result in the error message: "Unable to connect to '<ip 
address>'. Confirm valid IP address, SNMP settings or login, and if the network is 
functional." 

Note - VLAN Manager will not be able to connect to an AT-9700 device using an 
SNMPv3 account that has SHA authentication if the previous connection established with 
that device used an account with MD5 authentication. The same behavior will occur if 
VLAN Manager tries to connect using an account with MD5 authentication when the 
previous connection used an account with SHA authentication. 
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Authentication Protocol  
If the Security Level is "Auth / No Priv" or " Auth / Priv", you need to specify an 
Authentication Protocol that is configured for the User Account Name on the target 
device.  
These are the available Authentication Protocols:  
   
MD5  
Use HMAC-MD5-96 protocol  
   
SHA  
Use HMAC-SHA-96 protocol  
   
Authentication Password  
If the Security Level is "Auth / No Priv" or " Auth / Priv", you need to specify an 
Authentication Password that is configured for the User Account Name on the target 
device.  
   
Privacy Protocol  
If the Security Level is "Auth / Priv", you need to specify a Privacy Protocol. This is the 
available Privacy Protocol:  
   
DES  
Use Data Encryption Standard  
   
Privacy Password  
If the Security Level is "Auth / Priv", you need to specify a Privacy Password that is 
configured for the User Account Name on the target device.  
   

Login User Name  
This is the account name to be used to log in to the device. By default, this field is set to 
manager. This field is used for non-L2 devices only. For L2 devices, this field is ignored.  
   

Password  
This is the password for the account to be used. This field is used for non-L2 devices 
only. For L2 devices, this field is ignored.  
   

Retry Timeout  
The number of seconds VLAN Manager waits before it determines that the device is not 
responding. By default, this value is set to 5 seconds.  
   

Count  
The number of times VLAN Manager sends SNMP messages to the agent before giving 
up. By default, this value is set to 2 retries.  
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5.1.2 Close 

This option closes the active connection with the device and empties the VLAN Information 
Window. 

Note - This option is not available if VLAN Manager is not yet connected to a device. 

5.1.3 Properties 

The Properties dialog box allows you to modify the connection settings for the connected device. 
The Properties dialog box is identical to the Open dialog box used to open a connection. See 
Section 5.1.1 - Open. 

Note - This option is only available if VLAN Manager is already connected to a target host. 

5.1.4 Exit 

This option terminates connection to the target host and closes the VLAN Manager application. 

 
5 Menus 
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5.2 Edit 
 

The Edit menu lets you modify the VLAN configuration of the currently connected device. You 
can also save the VLAN configuration of the device to a file. 

Topics: 

• Add VLAN  
• Modify VLAN  
• Delete VLAN  
• Update VLAN Mode  
• Import VLAN  
• Export VLAN  

5.2.1 Add VLAN 

This option opens the Add VLAN dialog box that allows you to create a VLAN definition. 

 
Add VLAN dialog box 

5.2.1.1 Input Fields 

The Input Fields are the attributes that serve as VLAN creation parameters. These fields differ 
from one device family to another. In the illustration above, the device panel shown is for a 
Rapier 24i. Since the required Input Fields for the Rapier Family are Name, Identifier, and 
Operation Mode, these are the fields that are displayed in the Add VLAN dialog box. 

Refer to Section 6 - Device Support for details on the specific Input Fields available for each 
device family. 
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5.2.1.2 Adding/Removing Ports 

You can add ports to or remove ports from a VLAN definition by clicking on the port images on 
the device panel. Refer to Section 4.2 - Device Panel for details on how to specify tagged and 
untagged ports, uplink untagged and uplink tagged ports, private untagged and private tagged 
ports, core and customer ports and to unselect ports. 

 
Adding/Removing Ports 

In the illustration above, a new VLAN definition is being created for a Rapier 24i. The VLAN 
Name is "test" while its Identifier is "3". Ports 2 to 6 are untagged members while Port 1 is a 
tagged member of the VLAN. 

5.2.1.3 OK Button 

The OK Button is disabled by default. It is only enabled when both the Name and Identifier fields 
are populated. When the OK button is clicked, VLAN Manager adds the new VLAN definition to 
the target host and updates the VLAN Information Window. 

PN 613-50666-00 Rev C  Page 22 of 59 

 



Allied Telesyn AT-VIEW PLUS 
VLAN MANAGER

 

 
New VLAN definition added to VLAN Information Window 

After clicking the OK button, the new Add VLAN dialog will be closed and the new VLAN entry 
will be added to the Main window's Information Pane. 

5.2.1.4 Cancel Button 

The Cancel Button cancels the Add VLAN operation and closes the Add VLAN dialog box. 

5.2.2 Modify VLAN 

This option opens the Modify VLAN dialog box that allows you to change specific attributes of a 
VLAN. 

Note - This option is only available if a VLAN definition is selected. 

Refer to Section 4.1 - Selecting VLAN Definitions for details on how to select a VLAN 
definition. 
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Modify VLAN dialog box 

5.2.2.1 Input Fields 

The Input Fields are attributes of the VLAN definition to be modified. Depending on the device, 
one or more of the fields may be disabled and cannot be modified. 

Refer to Section 6 - Device Support for details on the specific attributes that can and cannot be 
modified for each device family. 

5.2.2.2 Modifying Ports 

You can add ports to or remove ports from a VLAN definition by clicking on the port images on 
the device panel. Refer to Section 4.2 - Device Panel for details on how to specify tagged and 
untagged ports, uplink untagged and uplink tagged ports, private untagged and private tagged 
ports, core and customer ports and to unselect ports. 

5.2.2.4 OK Button 

When the OK Button is clicked, VLAN Manager updates the VLAN definition in the target host 
and in the VLAN Information Window. 

5.2.2.5 Cancel Button 

The Cancel Button cancels the Modify VLAN operation and closes the Modify VLAN dialog 
box. 

5.2.3 Delete VLAN 

This option displays a delete VLAN confirmation dialog box. 

Note - This option is only available if a VLAN definition other than the default VLAN is 
selected. 
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Note - You may select multiple VLAN definitions (except for the default VLAN) for deletion. 

Refer to Section 4.1 - Selecting VLAN Definitions for details on how to select multiple VLAN 
definitions. 

 
Delete VLAN confirmation dialog box 

To remove the selected VLAN definition(s) from the target host and the VLAN Information 
Window, click Yes.  

5.2.4 Update VLAN Mode 

This option opens the Update VLAN Mode dialog box. 

Note - This option is only available to the AT-8000 Series, AT-8200XL Series, AT-8400, AT-
8500 Series, and AT-9400 Series. 

 
Update VLAN Mode dialog box 

Mode 

Sets the VLAN Mode for the device. The available options are: 

•  User Configured VLAN  
•  Multiple VLAN  
•  802.1Q Multiple VLAN  

Uplink Port 

Designates a port as the uplink port that can be connected to a shared device. 

Note - This field does not apply to the AT-8200XL Series. 
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5.2.5 Import VLAN 

This option opens the Import VLAN dialog box that allows you to import VLAN definitions 
from a VLAN Configuration File, modify the VLAN entries, and overwrite the existing VLAN 
entries on the currently connected device. 

 
Import VLAN dialog 

5.2.5.1 File Field and Browse Button 

You may specify a VLAN Configuration File (full path) in the File field. Alternatively, you can 
use the Browse button to locate the VLAN Configuration File to use. Once a valid VLAN 
Configuration File has been specified, the VLAN Definitions Table will be populated with the 
VLAN definitions contained in the file. You may then manually edit the definitions within the 
table. 

Note - Be sure to specify a VLAN Configuration File that contains VLAN entries suitable for the 
currently opened device. Otherwise, the Import VLAN function will fail. Refer to Section 4.3 - 
VLAN Configuration Files for more details. 

5.2.5.2 Add Button 

Clicking the Add Button adds an empty row to the VLAN Definitions Table. Once a row is added, 
it can be used to define a new VLAN. 
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5.2.5.3 Delete Button 

Clicking on the Delete Button removes the selected row(s) from the VLAN Definitions Table. 

5.2.5.4 OK Button 

Once the OK Button is clicked, VLAN Manager deletes all user-configured VLANs from the 
currently connected device and creates new user-configured VLANs based on the VLANs 
defined in the VLAN Definitions Table.  

5.2.6 Export VLAN 

This option opens a file browser dialog that allows you to specify a destination file and location 
in which to store exported VLAN definitions. Once a valid file and location is specified, VLAN 
Manager exports the VLAN definitions displayed in the VLAN Information Window to this file in 
CSV format. This file is then referred to as a VLAN Configuration File that can be used by the 
Import VLAN function.  

 
5 Menus 
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5.3 View 
 

The View menu lets you refresh the contents of the VLAN Information Window. 

Topics: 

• Refresh  

5.3.1 Refresh 

This option allows you to refresh the VLAN Information Window with the latest VLAN 
configuration of the currently connected device. 

Note - This option is only available if a VLAN Manager is already connected to a target host. 

 
5 Menus 
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5.4 Tools 
 

The Tools menu lets you restart the currently connected device. 

Topics: 

• Restart  

5.4.1 Restart 

This option displays a restart confirmation dialog box. 

Note - This option is only available if a VLAN Manager is already connected to a target host. 

Note - The restart option will not work for the AT-9400 series.  

 
Restart Confirmation dialog box 

To restart the currently connected device, click Yes. 

 
5 Menus 
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5.5 Help 
 

The Help menu lets you view the online user's guide as well as some basic information about the 
application. 

Topics: 

• Index  
• About  

5.5.1 Index 

This option displays this user's guide. 

Note - For HP-UX: 

• If there are no active Netscape sessions, selecting this option will not display the 
online help.  

• If there is one or more active Netscape session, selecting this option will cause 
one of the sessions to display the user's guide.  

5.5.2 About 

This option displays the version and copyright information for VLAN Manager. It also displays a 
list of the currently supported devices. 

 
5 Menus 

 

 

 

 

 

 
PN 613-50666-00 Rev C  Page 30 of 59 

 



Allied Telesyn AT-VIEW PLUS 
VLAN MANAGER

 

6 Device Support 
 

This section describes, on a per device family basis, the specific VLAN attributes displayed in 
the VLAN Information Window, the input fields that are available in the Add VLAN and 
Modify VLAN dialog boxes, and any known issues and/or operational notes. 

Topics: 

• AT-8000 Series  
• AT-8124XL (v2)  
• AT-8200XL Series  
• AT-8324  
• AT-8300GB Series  
• AT-8400  
• AT-8500 Series  
• AT-8600  
• AT-8700XL/AT-8800/Rapier Series  
• AT-8900/AT-9900 Series  
• AT-9400 Series  
• AT-9410GB  
• AT-9700 Series  
• AT-9800/SwitchBlade Series  
• AT-RG600 Series  

 
6 Device Support 
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6.1 AT-8000 Series 
 

Topics: 

• VLAN Information Window  
• Add/Modify VLAN Dialogs  

6.1.1 VLAN Information Window 

The VLAN Information Window displays the following attributes for each VLAN definition: 

Column Name Description 
Name This is the name of the VLAN. 
Identifier This is the unique identifier of the VLAN. 
Tagged Ports This is a list of the tagged member ports of the VLAN. 
Untagged Ports This is a list of the untagged member ports of the VLAN. 

Mirror Port This is the number of the port on which all VLAN traffic is 
mirrored. 

Status 

This indicates the status of the VLAN. 

• active  
• not in service  
• not ready  
• create and go  
• create and wait  
• destroy  

Note - If the selected Uplink Port is not connected to the Uplink VLAN, and the VLAN Mode is 
set to Multiple VLAN or 802.1Q Multiple VLAN, the connection with the device will be lost. 
Furthermore, no warning message will be displayed before the connection is lost. 
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6.1.2 Add/Modify VLAN Dialogs 

The Add/Modify VLAN Dialogs have the following Input Fields: 

Input Field Valid Values Length 

Name 

•  Alphanumeric characters  
•  Underscore ("_")  
•  Dash ("-")  

Note - VLAN names must contain at least one (1) 
alphabet character. 

Note - "ALL" is a reserved word and cannot be used as a 
VLAN name. 

1 - 19 characters 

Identifier (cannot 
be modified) 1 - 4094 - 

Mirror Port 

0-65535 

Note - The default value of 0 indicates that there is no 
port mirror defined for this VLAN. 

- 

 
 

 
6 Device Support 
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6.2 AT-8124XL (v2) 
 

Topics: 

• VLAN Information Window  
• Add/Modify VLAN Dialogs  

6.2.1 VLAN Information Window 

The VLAN Information Window displays the following attributes for each VLAN definition: 

Column Name Description 
Name This is the name of the VLAN. 
Identifier This is the unique identifier of the VLAN. 
Tagged Ports This is a list of the tagged member ports of the VLAN. 
Untagged Ports This is a list of the untagged member ports of the VLAN. 

Status 

This indicates the status of the VLAN. 

• idle  
• operational  
• under-construction  
• not-operational  

Note - An error message, "An error occurred during the operation. Error: Read only" will be 
displayed when the user tries to modify the Default VLAN. 

Note - After an Import VLAN operation of Multiple VLANs, all VLANs with valid VLAN 
definitions will have a successful status except for the Default VLAN. 

6.2.2 Add/Modify VLAN Dialogs 

The Add/Modify VLAN Dialogs display the following Input Fields: 

Input Field Valid Values Length 

Name 
•  Alphanumeric characters  
•  Underscore ("_")  
•  Dash ("-")  

0 - 20 characters 

Identifier 1 - 4094 - 
 
 

 
6 Device Support 
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6.3 AT-8200XL Series 
 

Topics: 

• VLAN Information Window  
• Add/Modify VLAN Dialogs  

6.3.1 VLAN Information Window 

The VLAN Information Window displays the following attributes for each VLAN definition: 

Column Name Description 
Name This is the name of the VLAN. 
Identifier This is the unique identifier of the VLAN. 
Member Ports This is a list of the member ports of the VLAN. 

Untagged Ports This is a list of the untagged (port-based) member ports of the 
VLAN. 

Status 

This indicates the status of the VLAN.  

• idle  
• operational  
• under-construction  
• not-operational  

Note - An error message, "An error occurred during the operation. Error: Bad Value." will be 
displayed when the user tries to modify the Default VLAN. 

Note - An error message, "An error occurred during the operation. Error: The device is in 
Multiple VLAN mode. Pre-configured VLANs cannot be displayed for this device." will be 
displayed when the VLAN Mode is set to Multiple VLAN and the VLAN definitions for the 
multiple VLANs were not displayed in the VLAN Information Window. 

Note - After an Import VLAN operation of Multiple VLANs, all VLANs with valid VLAN 
definitions will have a successful status except for the Default VLAN. 

Note - After an Import VLAN operation, VLAN definitions with out of range Member Ports will 
have a successful status. 

Note - If the selected Uplink Port is not connected to the Uplink VLAN, and the VLAN Mode is 
set to Multiple VLAN or 802.1Q Multiple VLAN, the connection with the device will be lost. 
Furthermore, no warning message will be displayed before the connection is lost.  
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6.3.2 Add/Modify VLAN Dialogs 

The Add/Modify VLAN Dialogs display the following Input Fields: 

Input Field Valid Values Length 

Name 
•  Alphanumeric characters  
•  Underscore ("_")  
•  Dash ("-")  

0 - 20 characters 

Identifier 1 – 4094 - 
 

 
6 Device Support 
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6.4 AT-8324 
 

Topics: 

• VLAN Information Window  
• Add/Modify VLAN Dialogs  

 

6.4.1 VLAN Information Window 

The VLAN Information Window displays the following attributes for each VLAN definition: 

Column Name Description 
Name This is the name of the VLAN. 
Identifier This is the unique identifier of the VLAN. 

<Stack ID> - Tagged Ports This is a list of the tagged member ports of the VLAN that belong 
to a specific module on the stack. 

<Stack ID> - Untagged 
Ports 

This is a list of the untagged member ports of the VLAN that 
belong to a specific module on the stack. 

Status 

This indicates the status of the VLAN. 

• active  
• not in service  
• not ready  
• create and go  
• create and wait  
• destroy  
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6.4.2 Add/Modify VLAN Dialogs 

The Add/Modify VLAN Dialogs display the following Input Fields: 

Input Field Valid Values Length 

Name 

•  Alphanumeric characters  
•  Underscore ("_")  
•  Dash ("-")  

Note - VLAN names must contain at least one (1) 
alphabet character. 

Note - "ALL" is a reserved word and cannot be used as a 
VLAN name. 

1 - 19 characters 

Identifier (cannot 
be modified) 1 - 2048 - 

 
 

6 Device Support 
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6.5 AT-8300GB Series 
 

Topics: 

• VLAN Information Window  
• Add/Modify VLAN Dialogs  

6.5.1 VLAN Information Window 

The VLAN Information Window displays the following attributes for each VLAN definition: 

Column Name Description 
Name This is the name of the VLAN. 
Identifier This is the unique identifier of the VLAN. 

<Stack ID> - Tagged Ports This is a list of the tagged member ports of the VLAN that belong 
to a specific module on the stack. 

<Stack ID> - Untagged 
Ports 

This is a list of the untagged member ports of the VLAN that 
belong to a specific module on the stack. 

Status 

This indicates the status of the VLAN. 

• idle  
• operational  
• under-construction  
• not-operational  

Note - Ports in the Default VLAN cannot be changed from untagged to tagged. 

Note - VLAN definitions that only contain tagged ports cannot be deleted. 

Note - VLAN definitions that only contain tagged ports cannot be deleted during an Import 
VLAN operation. 

Note - The retry timeout must be set to a higher value when adding or modifying VLAN 
definitions. The timeout value varies depending on the number of devices in the stack. 
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6.5.2 Add/Modify VLAN Dialogs 

The Add/Modify VLAN Dialogs display the following Input Fields: 

Input Field Valid Values Length 

Name 
•  Alphanumeric characters  
•  Underscore ("_")  
•  Dash ("-")  

0 - 20 characters 

Identifier 1 - 4094 - 
 

 
6 Device Support 
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6.6 AT-8400 
 

Topics: 

• VLAN Information Window  
• Add/Modify VLAN Dialogs  

6.6.1 VLAN Information Window 

The VLAN Information Window displays the following attributes for each VLAN definition: 

Column Name Description 
Name This is the name of the VLAN. 
Identifier This is the unique identifier of the VLAN. 

Type 

This indicates the type of the VLAN. 

• Port Based  
• MAC Based  
• Multiple  
• Multiple 802.1Q  

Tagged Ports This is a list of the tagged member ports of the VLAN. 
Untagged Ports This is a list of the untagged member ports of the VLAN. 

Status 

This indicates the status of the VLAN. 

• active  
• not in service  
• not ready  
• create and go  
• create and wait  
• destroy  

Note - If the selected Uplink Port is not connected to the Uplink VLAN, and the VLAN Mode is 
set to Multiple VLAN or 802.1Q Multiple VLAN, the connection with the device will be lost. 
Furthermore, no warning message will be displayed before the connection is lost. 

Note - Modifying the default VLAN definition will cause all other VLAN definitions to be 
deleted. Furthermore, the affected device should be reset after this error occurs. 
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6.6.2 Add/Modify VLAN Dialogs 

The Add/Modify VLAN Dialogs display the following Input Fields: 

Input Field Valid Values Length 

Name (cannot be 
modified) 

•  Alphanumeric characters  
•  Underscore ("_")  
•  Dash ("-")  

Note - VLAN names must contain at least one (1) 
alphabet character. 

1 - 19 characters 

Identifier (cannot 
be modified) 1 - 4094 - 

 
 

6 Device Support 
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6.7 AT-8500 Series 
 

Topics: 

• VLAN Information Window  
• Add/Modify VLAN Dialogs  

6.7.1 VLAN Information Window 

The VLAN Information Window displays the following attributes for each VLAN definition: 

Column Name Description 
Name This is the name of the VLAN. 
Identifier This is the unique identifier of the VLAN. 
Tagged Ports This is a list of the tagged member ports of the VLAN. 
Untagged Ports This is a list of the untagged member ports of the VLAN. 

Status 

This indicates the status of the VLAN. 

• active  
• not in service  
• not ready  
• create and go  
• create and wait  
• destroy  

Note - If the selected Uplink Port is not connected to the Uplink VLAN, and the VLAN Mode is 
set to Multiple VLAN or 802.1Q Multiple VLAN, the connection with the device will be lost. 
Furthermore, no warning message will be displayed before the connection is lost. 

Note - The current firmware version does not allow the Default VLAN to be modified. As a 
result, all AT-View Plus VLAN Manager operations involving the Default VLAN will fail.  

Note - For 20-character VLAN Names entered via telnet, only the first 19 characters are 
registered in VLAN Manager.  

Note - AT-8550 : Changing the VLAN Mode parameter setting from '802.1Q Multiple VLAN' to 
a different mode may result in the error message: "Unable to communicate. Confirm SNMP 
settings or login, and if the network is functional." However, VLAN Mode is still set to the new 
mode successfully. To prevent this error message from reappearing, go to File -> Properties and 
increase the Retry Timeout value.  
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6.7.2 Add/Modify VLAN Dialogs 

The Add/Modify VLAN Dialogs have the following Input Fields: 

Input Field Valid Values Length 

Name 

•  Alphanumeric characters  
•  Underscore ("_")  
•  Dash ("-")  

Note - VLAN names must contain at least one (1) 
alphabet character. 

1 - 20 characters 

Identifier (cannot 
be modified) 1 - 4094 - 

Note - For the VLAN Name parameter, the current firmware version allows up to 19 characters 
to be entered via SNMP and up to 20 characters via telnet. Since AT-View Plus VLAN Manager 
is an SNMP-based application, the 19-character limit will apply to all operations involving 
VLAN Name.  

Note - AT-8550 : The current firmware version does not allow AT-View Plus VLAN Manager to 
perform Add VLAN, Modify VLAN and Import VLAN operations that involve ports 33 to 50. 
Attempting to perform such operations will result in the error message: "An error occurred during 
the operation. Error: Wrong value."  

 
6 Device Support 

 

 

 

 

 

 

 

 

 
PN 613-50666-00 Rev C  Page 44 of 59 

 



Allied Telesyn AT-VIEW PLUS 
VLAN MANAGER

 

6.8 AT-8600 
 

Topics: 

• VLAN Information Window  
• Add/Modify VLAN Dialogs  

6.8.1 VLAN Information Window 

The VLAN Information Window displays the following attributes for each VLAN definition: 

Column Name Description 
Name This is the name of the VLAN. 
Identifier This is the unique identifier of the VLAN. 
Operation Mode This indicates the operation mode of the VLAN. 
Tagged Ports This is a list of the tagged member ports of the VLAN. 
Untagged Ports This is a list of the untagged member ports of the VLAN. 
Uplink Port This is a list of the uplink ports of the VLAN. 
Private Ports This is a list of the private ports of the VLAN. 

Status 

This indicates the status of the VLAN. 

• dynamic  
• static  

Note - When importing the default VLAN, VLAN Manager disregards the values specified for 
Untagged Ports.  

Note - When performing an Import VLAN operation, if the specified Operation Mode is Normal 
or Protected, the Uplink Ports and Private Ports fields will be ignored by the application.  

Note - When two Private VLANs specify the same Uplink port (Uplink port is untagged for the 
first Private VLAN and tagged for the second Private VLAN), modifying the Private VLAN that 
has the untagged Uplink port will result in the error message: "<VLAN Name> already has an 
uplink, more than one Uplink is not permitted." All ports in that Private VLAN will then be 
deleted.  

Note - A GBIC image is always visible on the GBIC slot of the AT-A47 expansion module 
image even if there is no GBIC physically inserted. Furthermore, the GBIC image will always 
show an SC port regardless of the actual type of GBIC used.  
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6.8.2 Add/Modify VLAN Dialogs 

The Add/Modify VLAN Dialogs have the following Input Fields: 

Input Field Valid Values Length 

Name (cannot be 
modified) 

•  Alphanumeric characters  
•  Underscore ("_")  
•  Dash ("-")  

Note - VLAN names must contain at least one (1) 
alphabet character. 

Note - "ALL" is a reserved word and cannot be used as a 
VLAN name. 

1 - 15 characters 

Identifier (cannot 
be modified) 1 - 4094 - 

Operation Mode 
(cannot be 
modified) 

•  Normal  
•  Private  
•  Protected  

- 

 
 

6 Device Support 
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6.9 AT-8700XL/AT-8800/Rapier Series 
 

Topics: 

• VLAN Information Window  
• Add/Modify VLAN Dialogs  

6.9.1 VLAN Information Window 

The VLAN Information Window displays the following attributes for each VLAN definition: 

Column Name Description 
Name This is the name of the VLAN. 
Identifier This is the unique identifier of the VLAN. 
Operation Mode This indicates the operation mode of the VLAN. 
Tagged Ports This is a list of the tagged member ports of the VLAN. 
Untagged Ports This is a list of the untagged member ports of the VLAN. 
Uplink Port This is a list of the uplink ports of the VLAN. 
Private Ports This is a list of the private ports of the VLAN. 

Status 

This indicates the status of the VLAN. 

• dynamic  
• static  

Note - The Operation Mode is not available if the software release version used on the AT-
8700XL is 2.6.4-00 to 2.6.4-02  

Note - Adding a Private VLAN with a Private Port that has already been associated with the 
Default VLAN as a Tagged Port will result to an error. However, the Private VLAN will still be 
added on the device with only the Uplink Port configured.  

Note - When importing the default VLAN, VLAN Manager disregards the values specified for 
Untagged Ports.  

Note - On Import VLAN operation, if the specified Operation Mode is Normal, the Uplink Port 
and Private Ports fields will be ignored by the application.  

Note - When two Private VLANs specify the same Uplink port (Uplink port is untagged for the 
first Private VLAN and tagged for the second Private VLAN), modifying the Private VLAN that 
has the untagged Uplink port will result in the error message: " already has an uplink, more than 
one Uplink is not permitted." All ports in that Private VLAN will then be deleted.  
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6.9.2 Add/Modify VLAN Dialogs 

The Add/Modify VLAN Dialogs have the following Input Fields: 

Input Field Valid Values Length 

Name (cannot be 
modified) 

•  Alphanumeric characters  
•  Underscore ("_")  
•  Dash ("-")  

Note - VLAN names must contain at least one (1) 
alphabet character. 

Note - "ALL" is a reserved word and cannot be used as a 
VLAN name. 

1 - 15 characters 

Identifier (cannot 
be modified) 1 - 4094 - 

Operation Mode 
(cannot be 
modified) 

If the firmware version is 2.6.4 (AT-8800 / Rapier): 

• Normal  
• Private  

If the firmware version is 2.6.3 or lower: 

• Normal  
• Protected  

If the firmware version is 2.6.4-03 to 2.6.4-05 (AT-
8700XL): 
If the firmware version is 2.6.4-04 to 2.6.4-05 (AT-8800): 
If the firmware version is 2.6.1-10 to 2.6.1-12 and 2.6.4-
04 to 2.6.4-05 (Rapier): 

• Normal  
• Protected  
• Private  

- 

 
 

6 Device Support 
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6.10 AT-8900/AT-9900 Series 
 

Topics: 

• VLAN Information Window  
• Add/Modify VLAN Dialogs  

6.10.1 VLAN Information Window 

The VLAN Information Window displays the following attributes for each VLAN definition: 

Column Name Description 
Name This is the name of the VLAN. 
Identifier This is the unique identifier of the VLAN. 
Operation Mode This indicates the operation mode of the VLAN. 

Type 

This indicates the type of the VLAN. 

• Port-based  
• Multiple Type  

Tagged Ports This is a list of the tagged member ports of the VLAN. 
Untagged Ports This is a list of the untagged member ports of the VLAN. 
Uplink Port This is a list of the uplink ports of the VLAN. 
Private Ports This is a list of the private ports of the VLAN. 
Core Ports This is a list of the core ports of the VLAN. 
Customer Ports This is a list of the customer ports of the VLAN. 

Status 

This indicates the status of the VLAN. 

• dynamic  
• static  

Note - When adding/modifying a Nested VLAN, specifying a port that is already a member of an 
existing Normal VLAN will not generate any error. However, the specified port will be ignored. 
In addition, during modification, existing member ports having the same status (tagged/untagged) 
as the specified port will be deleted.  

Note - When importing the default VLAN, VLAN Manager disregards the values specified for 
Untagged Ports.  

Note - For the Import VLAN operation:  

• If the specified Operation Mode is Normal - the Uplink Ports, Private Ports, Core Ports 
and Customer Ports fields will be ignored.  
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• If the specified Operation Mode is Private - the Core Ports and Customer Ports fields will 

be ignored.  
• If the specified Operation Mode is Nested - the Tagged Ports, Untagged Ports, Uplink 

Ports and Private Ports fields will be ignored.  

Note - User-created VLANs are classified as Multiple Type VLANs. There are three possible 
VLAN associations for a Multiple Type VLAN: IP Subnet, Protocol and Port. Currently, VLAN 
Manager only supports Port association. As a result, when attempting to modify a VLAN with an 
association other than Port, VLAN Manager automatically changes the association of that VLAN 
to Port.  

Note - AT-9900 : When adding/modifying a Nested VLAN, specifying 2 or more core ports 
where one of the specified ports is already a member of an existing Nested VLAN will result in 
the error message: "Must return port <n> to the default VLAN as untagged port based."  

6.10.2 Add/Modify VLAN Dialogs 

The Add/Modify VLAN Dialogs have the following Input Fields: 

Input Field Valid Values Length 

Name (cannot be 
modified) 

•  Alphanumeric characters  
•  Underscore ("_")  
•  Dash ("-")  

Note - VLAN names must contain at least one (1) 
alphabet character. 

Note - "ALL" is a reserved word and cannot be used as a 
VLAN name. 

1 - 15 characters 
(AT-8900) 

1 - 32 characters 
(AT-9900) 

Identifier (cannot 
be modified) 1 - 4094 - 

Operation Mode 
(cannot be 
modified) 

•  Normal  
•  Private  
•  Nested  

- 

 
 

6 Device Support 
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6.11 AT-9400 Series 
 

Topics: 

• VLAN Information Window  
• Add/Modify VLAN Dialogs  

6.11.1 VLAN Information Window 

The VLAN Information Window displays the following attributes for each VLAN definition: 

Column Name Description 
Name This is the name of the VLAN. 
Identifier This is the unique identifier of the VLAN. 
Tagged Ports This is a list of the tagged member ports of the VLAN. 
Untagged Ports This is a list of the untagged member ports of the VLAN. 

Status 

This indicates the status of the VLAN. 

• idle  
• operational  
• under-construction  
• not-operational  

Note - If the selected Uplink Port is not connected to the Uplink VLAN, and the VLAN Mode is 
set to Multiple VLAN or 802.1Q Multiple VLAN, the connection with the device will be lost. 
Furthermore, no warning message will be displayed before the connection is lost. 

Note - The current firmware version does not allow AT-View Plus VLAN Manager to 
distinguish between Protected VLANs and standard Port-based VLANs. As a result, AT-View 
Plus VLAN Manager will display and treat Protected VLANs as if they were standard Port-based 
VLANs. Furthermore, modifying a Protected VLAN will convert that VLAN into a standard 
Port-based VLAN.  

Note - The current firmware version does not allow the Default VLAN to be modified. As a 
result, all AT-View Plus VLAN Manager operations involving the Default VLAN will fail.  

Note - The VLAN Mode parameter can only be set to a different mode if it is currently set to 
'User Configured VLAN'. However, changing the mode from 'User Configured VLAN' to 
'Multiple VLAN' will set VLAN Mode to '802.1Q Multiple VLAN'. On the other hand, changing 
the mode from 'User Configured VLAN' to '802.1Q Multiple VLAN' will set VLAN Mode to 
'Multiple VLAN'.  

Note - For 20-character VLAN Names entered via telnet, only the first 19 characters are 
registered in VLAN Manager.  
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6.11.2 Add/Modify VLAN Dialogs 

The Add/Modify VLAN Dialogs have the following Input Fields: 

Input Field Valid Values Length 

Name 

•  Alphanumeric characters  
•  Underscore ("_")  
•  Dash ("-")  

Note - VLAN names must contain at least one (1) 
alphabet character. 

1 - 20 characters 

Identifier (cannot 
be modified) 1 - 4094 - 

Note - For the VLAN Name parameter, the current firmware version allows up to 19 characters 
to be entered via SNMP and up to 20 characters via telnet. Since AT-View Plus VLAN Manager 
is an SNMP-based application, the 19-character limit will apply to all operations involving 
VLAN Name.  

 
6 Device Support 
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6.12 AT-9410GB 
 

Topics: 

• VLAN Information Window  
• Add/Modify VLAN Dialogs  

6.12.1 VLAN Information Window 

The VLAN Information Window displays the following attributes for each VLAN definition: 

Column Name Description 
Name This is the name of the VLAN. 
Identifier This is the unique identifier of the VLAN. 
Tagged Ports This is a list of the tagged member ports of the VLAN. 
Untagged Ports This is a list of the untagged member ports of the VLAN. 

Status 

This indicates the status of the VLAN. 
• idle  
• operational  
• under-construction  
• not-operational 

Note - Ports in the Default VLAN cannot be changed from untagged to tagged. 

Note - VLAN definitions that only contain tagged ports cannot be deleted. 

Note - When adding/importing VLAN definitions with a blank VLAN name attribute cannot be 
created/imported. The Import operation for those definitions will fail. 

Note - VLAN definitions that only contain tagged ports cannot be deleted during an Import 
VLAN operation. 

6.12.2 Add/Modify VLAN Dialogs 

The Add/Modify VLAN Dialogs display the following Input Fields: 

Input Field Valid Values Length 

Name 
•  Alphanumeric characters  
•  Underscore ("_")  
•  Dash ("-")  

0 - 20 characters 

Identifier 1 - 4094 - 
 

 
6 Device Support 

PN 613-50666-00 Rev C  Page 53 of 59 

 



Allied Telesyn AT-VIEW PLUS 
VLAN MANAGER

 

6.13 AT-9700 Series 
 

Topics: 

• VLAN Information Window  
• Add/Modify VLAN Dialogs  

6.13.1 VLAN Information Window 

The VLAN Information Window displays the following attributes for each VLAN definition: 

Column Name Description 
Name This is the name of the VLAN. 
Identifier This is the unique identifier of the VLAN. 

Type 

This indicates the type of the VLAN. 

• 1q_vlan  
• protocol  

Advertisement 

This specifies that the VLAN is able to join GVRP. 

• Enabled  
• Disabled  

Tagged Ports This is a list of the tagged member ports of the VLAN. 
Untagged Ports This is a list of the untagged member ports of the VLAN. 
Forbidden Ports This is a list of the forbidden member ports of the VLAN. 

Note - The current firmware version allows a maximum of 32 characters for the VLAN Name 
parameter. When adding ports 1 and/or 2 as tagged/untagged ports of a VLAN whose name is of 
length 32, an additional character is appended to the name thereby causing the name to exceed 32 
characters. When this happens, problems may be encountered while attempting to modify or 
delete this VLAN. 

Note - The current firmware version allows you to pre-configure switches that may be added to 
the stack in the future. Pre-configured switches are identified by a “Non-Existing” label that 
appears above the device panel in the Add VLAN and Modify VLAN dialog boxes. Ports on pre-
configured switches can be included in a VLAN but only those marked as “untagged” or 
“forbidden” will appear on the VLAN Information Window. Ports marked as “tagged” will not 
appear. They will appear only when a physical switch, whose box id matches the box id of the 
pre-configured switch to which the tagged ports belong, is added to the stack. 
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6.13.2 Add/Modify VLAN Dialogs 

The Add/Modify VLAN Dialogs have the following Input Fields: 

Input Field Valid Values Length 

Name (cannot be 
modified) •  Alphanumeric characters except the double quote (")  1 - 32 characters 

Identifier (cannot 
be modified) •  2 - 4094  - 

Advertisement 
(cannot be 
modified if VLAN 
Type is Protocol) 

•  Enabled  
•  Disabled  - 
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6.14 AT-9800/SwitchBlade Series 
 

Topics: 

• VLAN Information Window  
• Add/Modify VLAN Dialogs  

6.14.1 VLAN Information Window 

The VLAN Information Window displays the following attributes for each VLAN definition: 

Column Name Description 
Name This is the name of the VLAN. 
Identifier This is the unique identifier of the VLAN. 
Tagged Ports This is a list of the tagged member ports of the VLAN. 
Untagged Ports This is a list of the untagged member ports of the VLAN. 

Type 

This indicates the type of the VLAN. 

• Port-based  
• IP subnet-based  
• Protocol-based  
• MAC address-based  
• Limited protocol-based  

Status 

This indicates the status of the VLAN. 

• dynamic  
• static  

Note - After Import VLAN operation, Default VLAN with invalid Untagged Ports will have 
successful status.  
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6.14.2 Add/Modify VLAN Dialogs 

The Add/Modify VLAN Dialogs have the following Input Fields: 

Input Field Valid Values Length 

Name (cannot be 
modified) 

•  Alphanumeric characters  
•  Underscore ("_")  
•  Dash ("-")  

Note - VLAN names must contain at least one (1) 
alphabet character. 

Note - "ALL" is a reserved word and cannot be used as a 
VLAN name. 

1 - 15 characters 

Identifier (cannot 
be modified) 

•  1 - 4090 (AT-9800 Series)  
•  1 - 4078 (SwitchBlade Series)  - 
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6.15 AT-RG600 Series 
 

Topics: 

• VLAN Information Window  
• Add/Modify VLAN Dialogs  

6.15.1 VLAN Information Window 

The VLAN Information Window displays the following attributes for each VLAN definition:  

Column Name Description 
Name This is the name of the VLAN. 
Identifier This is the unique identifier of the VLAN. 
Tagged Ports This is a list of the tagged member ports of the VLAN. 
Untagged Ports This is a list of the untagged member ports of the VLAN. 
Priority This indicates the 802.1p Priority. 

Status 

This indicates the status of the VLAN. 

• static  

Note - VLANs whose names start with a number cannot be deleted.  

6.15.2 Add/Modify VLAN Dialogs 

The Add/Modify VLAN Dialogs have the following Input Fields: 

Input Field Valid Values Length 

Name (cannot be 
modified) 

•  Alphanumeric characters  
•  Underscore ("_")  
•  Dash ("-")  

Note - VLAN names cannot start with a digit and cannot 
contain period '.' or slash symbols '/'. 

1 - 15 characters 

Identifier (cannot 
be modified) 

•  1 - 512 (AT-RG656BD)  
•  1 - 4094 (AT-RG613TX / AT-RG613SH) - 

Priority (cannot be 
modified) 

•  0 - 7  

Note - This field is implemented as a drop-down list. 
- 
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Note - AT-RG634A : As a general rule, a port can be a member of several VLANs but can only 
be an untagged member of one VLAN. The current firmware version for the AT-RG600 ADSL 
series, however, operates differently and does not follow this rule. If a port is initially an 
untagged member of a VLAN, then it can no longer be a member of other VLANs. On the other 
hand, if a port is initially a tagged member of a VLAN, then it can only be added to other VLANs 
as a tagged member also.  

                                                                                                                                6 Device Support 
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